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 I cannot believe that I am 
just coming to the end of my fi rst 
year as President, it has passed by 
very quickly and I must say I have 
enjoyed myself.  It has been a chal-
lenging year with many obstacles 
to overcome and changes to bring 
about.   

 The major change being 
the introduction of digital imag-
ing into the league and the exhibi-
tion.  This coming year will  be a 
learning curve for us all and I hope 
clubs will be able to work together 
to ensure the smooth running of 
the league.  

 I also urge judges to be pa-
tient with the clubs they are visit-
ing if things do not run as smooth-
ly as they should.  The main thing 
is for clubs to ensure they talk 
with each other early enough to 
overcome any problems before 
the judging night.  It would be re-

ally great if more members could 
support their clubs away rounds 
as well, I always feel sorry for 
the visiting clubs when is all they 
have in attendance, is the compe-
tition secretary and perhaps one 
other, after all this competition is 
run for all members to enjoy, not 
just a selected few.  It is by seeing 
many images on a regular basis in 
competitions and exhibitions that 
we get ideas and enthusiasm for 
our own photography and learn to 
improve.

 Can I remind the pro-
gramme secretaries when setting 
out their new programmes for 
2010 to remember to try and book 
the new judges we enlisted last 
November, also don’t forget to use 
the preliminary judges as the more 
judging they do, the more likely 
they are to go for an assessment 
to upgrade to panel B at our next 
judging seminar.  These people are 
enthusiastic to come to your club 
and share their knowledge and ex-
perience.  

 Another plea to the pro-
gramme secretaries, when booking 
judges for a league round, please 
inform them it is a league match 
and ask fi rst if they already have 
any bookings within your  region.   

 If you are already a panel 
B judge and want to upgrade, re-
member to keep a note of the 
bookings you have had, as it will 
be asked for when you apply to 
upgrade to panel A.  

 We hope that the next 
judging assessment will again en-

courage high numbers to people to 
come forward.  If you are thinking 
that you might like to be assessed 
as a judge then please log your in-
terest with our secretary so we can 
make a decision on when to hold 
the next judging seminar.  

 In the meantime, keep tak-
ing pictures, remember it’s good 
for your health to be out walking 
come rain or shine and apparently 
there are good pictures to be had in 
the rain – I must try it sometime.

Lynn Lambeth.

The offi cial organ of the Southern photographic Federation.
Published four times yearly, February, May, September and December.

May 2009

President’s Piece

http://www.southernfed.org.uk

FOR SALE
JOBO 6600 Enlarger with Schneider 
Componar 50mm and 75mm lenses. 
Also complete dark room equipment .
If interested contact Roy Lambeth on  
023 8032 3431.
_ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ _ 

RAMBLING THOUGHTS.... 

I was thinking that women should put 
pictures of missing husbands on beer 
cans!

I thought about making a movie for folks 
my age and call it “Pumping Rust.” 

You know when people see a cat’s litter 
box, they always say, “Oh, have you got 
a cat?” Just once I wanted to say, “No, 
it’s for company!” 
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Southern Photographic Federation
PRINT BOXES

Standard Model – 21” x 17” x 1 5/8ths”.
Rolled top edges, black plastic corners,

two straps.

PRICE - £14-75

Orders in writing and with cheques payable to J. 
PEARSON 
to Mrs. Jennie Pearson, 6, Inhams Road, Holybourne, 
ALTON, Hants. GU34 4EU.

The next order date is to be arranged. If you can get 
your orders in early it would be appreciated.

Boxes to be collected at the following Reps. 
Meeting.

Details of other sizes and costs:
21” x 17” x 2”   £16-25
21” x 17” x 2.5”   £16-50
21” x 17” x 3”   £16-75
21” x 17” x 3.5”   £17-25
21” x 17” x 4”   £17-50
21” x 17” x 5”   £18-00
21” x 17” x 6”   £18-25 

Jennie Pearson.  Alton Camera Club.   Tel:- 01420 
88743

These prices were correct for the March 2009 order

newsletter and you do not have 
to wait until the AGM to express 
an interest, just contact the 
President or the Secretary and 
let them know that at some stage 
in the future you would be willing 
to join the Council. The Council 
are not getting any younger and 
will always be looking for new 
blood. So do your bit for the 
Federation.

 As you hopefully have 
noticed, Les Lloyd has been 
trying out a new web layout. He 
has hopes that by the time that 
you read this it will be live. It 
certainly has a different look 
about it and hopefully will be 
easy enough for all to navigate 
through. A lot of the archived 
material will still be there - 
Newsletters, Roll of Honour, 
Quarterly Minutes etc. - but 
there will be a whole lot more. 
The front page will include 
adverts from our sponsors and 
some of these may also appear 
on specifi c pages. Upcoming 
events will also appear on the 
front page as will the Diary. 
Les will take any constructive 
criticisms should anything not 
be to your liking, though it 
should be emphasized that not 
every idea can be incorporated.
 If you have something 
coming up within your Club that 

 
 As I sit at the computer 
compiling this newsletter for 
the May meeting, on this sunny 
Bank Holiday Monday, I am 
wondering why I am not out 
getting some fresh air and of 
course enjoying taking a few 
photographs. It is then that I 
realise that as usual we have the 
problem of enticing volunteers 
to the SPF Council. 
 
 Every Club in the region 
knows that posts come up for 
renewal each May and every 
Club is reminded of this, but 
do we get volunteers come 
forward, NO! Though it has to 
be said that in recent weeks, 
Council have been able to co-
opt Les Lloyd onto the Council 
to help in updating the website 
and also take on the League 
Competitions. On a personal 
note, I would like to thank Les 
for relieving me of looking 
after the website, as my other 
commitments (work etc.) have 
been taking up so much of my 
time. 
 It could be that Club 
members are not informed that 
Council are looking for people 
to take on posts (shame on you), 
but it is often mooted in the 

Editor’s Notes you would like others to know of, 
let him know and he will add that 
to the page also.

 Now for some very advance 
notice - I will be away in October 
this year and would appreciate 
anything for inclusion very soon 
after the September meeting, so 
that I can get as much done as 
possible before I go away. If you 
have anything which is not time 
sensitive you can send it to me 
anytime from now and say that 
it is for the October issue. That 
doesn’t mean to say I wouldn’t 
need anything for the September 
issue as items are required for 
every issue.

 What is happening in your 
Club? - let me have a couple of 
paragraphs to include in the 
next issue(s). I can also include 
photographs and/or cartoons, 
photographic jokes and letters or 
questions.

 Take care during the 
summer and collect some great 
images.
 Trevor
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 There were just Twenty 
One clubs participating this year. 
This being the same as last year, 
although two clubs had dropped 
out and two new clubs entered. 
Even the attendance was very 
similar, although the weather 
was quite different from the 
snow the previous year.

 The three Judges 
all of whom had judged 
similar Championships and 
Internationals were surprised 
that a Federation our size had 
such a small club entry. Even 
there own Region with less clubs 
had a larger input. The 3,3,4, 
Trophy they thought was very 
novel and would be suggesting 
this to there own Region.

 The judges scored to the 
standard that one might expect 
at the P.A.G.B. Championships, 
which many thought very 
harsh. The Winning and Runner 
up clubs never had a 15 or 14 

awarded. The only 15 was by 
the club which came 19th. For 
the 3,3,4, Trophy there were 
only two clubs who had 10s in 
double figures. If you thought 
that a lot of 10s were awarded 
then 25% of the entry were 
awarded them.

 The full results have 
been well published on the 
Websites so there is no need 
to reiterate them here. It was a 
pity that none of the recipients 
for the P.A.G.B. Medals were in 
attendance, but were accepted 
on their behalf by there clubs 
representative.

 I did have a possible 
Sponsor for future Digital 
Projection Championships but 
this has now been withdrawn 
due to the poor response in clubs 
participation with no increase 
seeing the number of clubs we 
have. They were looking for 
50% or more where we can 
only muster 30% and that is not 
guaranteed. 

 Our thanks must go 

to Rita Robertson and other 
members of the Newbury C.C. 
for the part they played in 
making the day the success that 
it was. One must also thank 
Tristram Reed for compiling 
the entries and providing help to 
many with their entry. George 
Walsh and Steve Kirby for there 
help on the day.

 Let us hope that the 
Winning Club and Runner up 
both of whom will represent us 
in the P.A.G.B. Championships 
do well.

Ernie Fullbrook. BEM, APAGB. 
D.P.C. Organiser for Council

THE SOUTHERN PHOTOGRAPHIC FEDERATIONS 
3rd  INTER CLUB

DIGITAL PROJECTION CHAMPIONSHIP.

HAVANT CAMERA CLUB EXHIBITION
Havant CC is holding its annual exhibition shortly.
 
This year, for the first time, we are members of the British Photographic 
Exhibitions (BPE) circuit and are expecting a greater number of entries 
and an even better exhibition.  Anyone who has images accepted will be 
able to count them towards the BPE Crown Awards – see their website 
for more details: http://www.bpe.uk.net/
 
I would be grateful if you could remind your members of the closing 
date for the exhibition which is Saturday, 23rd May 2009 and 
encourage them to enter.

An entry form can be downloaded from the website at http://www.
havantcameraclub.co.uk

http://www.havantcameraclub.co.uk
http://www.havantcameraclub.co.uk
http://www.nomadplc.co.uk/
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IMPORTANT 
NEWS ABOUT 
SPF WEBSITE    
 
Can I please ask you to ensure 
all members of your club are sent 
this note.
 
We are fortunate to have Les 
Lloyd join the Council and he is 
already working with Trevor to 
redesign our website.  You will 
see the front page is very different 
than previously and we have many 
good ideas for improving on the 
old website.  Please take time to 
visit the new site and see how it 
is developing www.southernfed.
org.uk/newWeb/spf/  

I would like to say this is in 
development stage and you will 
see if you visit the site regularly 
that it is being phased with all new 
information in the new format 
but with the old information still 
available in the old format, the 
new site is being built in parallel 
to the old site which we hope to 
switch off in a few weeks time, 
so I ask you to be patient, but 

to let our secretary have your 
comments on what you see and 
any content that you would like 
added, such as a club exhibition 
or major event.
 
We will also be having a gallery 
of images included within the 
site and will display winners of 
the League and Championships 
so you may even see one of 
your images on the site at some 
point.  We are also considering 
including a small ads section, if 
there is enough interest for people 
wanting to sell equipment.
 
The new site will be very easy to 
navigate and we hope you will 
all use it a lot more to find out 
the information including; Club 
Reps meetings, competitions, 
Newsletter and also what events 
are happening around our 
region.
 
Don’t forget all our sponsors 
are advertising on the website 
do please use them and let them 
know where you saw their advert 
- the money generated from these 
sponsors directly works to keep 
your subscriptions lower.
 
Lynn Lambeth, President.

SPF Annual 
Exhibition 

at Salisbury
Don’t forget the entry 
forms must be returned 
to George Walsh by 31st 
August 2009. This is 
before most Clubs start 
the new season. 

Plan ahead. 

http://www.southernfed.org.uk/newWeb/spf/
http://www.southernfed.org.uk/newWeb/spf/
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Before you open the file you want 
to resize, open the Colour Set-
tings using Shift + Ctrl + K (or 
look under the Edit menu). Make 
sure your RGB Working Space is 
set to sRGB, as this is the most 
compatible option for projectors, 
and will be compatible with you 
printer too. Make sure your RGB 
Colour
Management Policy is set to 
“Convert to Working RGB”, with 
the Profile Mismatch and Profile 
Missing,  Ask When Opening/
Pasting boxes are checked.

Now all the files you open will 
be converted to the sRGB Colour 
space and will be automatically 
compatible. (If you prefer to print 
in a different Colour Space/Gam-
ut, remember to convert the file 
for digital projection to sRGB to 
ensure the closest colour match to 
your original is projected. If the 
colour space is not set to sRGB, 
the image colours may be project-
ed differently.)

Once the file is open in Photoshop, 

open the Image menu (top left) to 
bring up the Mode, make sure 8 
bits/channel is ticked, and either 
Greyscale or RGB Colour is se-
lected. If not change the mode to 
RGB and 8 bits/channel.

Now you need to make sure you 
have no extra Layers, Channels or 
Paths in your file. You can do that 
easily by looking at the relevant 
palettes. F7 opens the Layers pal-
ette, (or use the Window Menu 
to open it. You will probably 
have it open in the bottom left of 
your screen already). If you have 
more than one layer, or any layer 
masks, go to the Layer Menu (top 
left) and Flatten Image, now you 
should have only one thumbnail 
visible in the Layers Palette.

In the Paths Palette, make sure you 
have no Working Paths thumb-
nails, if you do delete the paths 
(right-click on the thumbnail, and 
choose delete path).

Moving across to the Channels 
Palette, you should have four visi-
ble channels in RGB Mode; RGB, 
Red, Green and Blue. Greyscale 
mode has only one channel, if you 
have any excess channels in either 
mode, delete them. 

Nearly there, now you just need 
to resize the image. Select Image 
Size from the Image Menu, or Alt 
+ Ctrl + I, before altering the sizes 
make sure the Constrain Propor-
tions box is selected. Then if you 
have a Resample Image choice, 
choose Bicubic or Bicubic Sharp-
er for the best quality reduction. 
Now you can enter the Pixel Di-
mensions, for OSPS Competi-

tions the current rules are a maxi-
mum of 1024 pixels wide, by 768 
pixels high.

Other external competitions will 
vary, and it is best to supply im-
ages in the native resolution of the 
projector where possible so you 
could change the pixel dimensions 
on the original to be larger than 
the 1024 by 768 format. I strongly 
recommend that you never scale 
an image up to make it larger, it 
will degrade the quality.

If you do not have a larger file to 
scale down from, just project the 
image at the size you have it.

DPI has no relevance for digital 
projectors and will not change the 
size of the file or the projected 
image, but 96dpi is an accepted 
if somewhat irrelevant choice. 
Click OK, and now you just have 
to save the file, USE Save As, so 
that the changes do not alter your 
original image, and now you can 
save it under the preferred file 
naming format for either internal 
or external club competitions.

Wow, what an effort! But now 
you will have the image set up 
correctly to be projected in the 
optimal format!

Congratulations, and good luck, 
I hope you get the mark you de-
serve.

For further advice or One-to-One 
Photoshop tuition, on your own 
computer using your images as 
teaching examples, contact Chris 
Neill-Griffin 01794 501104 or 
email: chris.neillgriffin@gmail.com

Resizing in Photoshop & Preparing images for 
Digital Projection Competitions
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May 
8 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm
21 Summer Representatives Meeting at   
 Littlton Millennium Memorial Hall, @  
 7.45pm - Prints for PAGB Inter-Fed   
 Competition should be handed in at this  
 meeting.

June 
4 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm

July 
8 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm
9 Last date for Handbook information
TBA PAGB Inter Club Slide Championships  
 Warwick

August 
12 Copy for Southern Focus deadline

September 
7 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm
15 Autumn Representatives Meeting at Littlton
 Millennium Memorial Hall, @ 7.45pm.
30 PAGB Inter-Fed Projected Image   
 Competition hosted by CACC. A disc of   
 images for consideration must be handed in  
 at the Autumn Reps Meeting.

October 
7 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm
12 Copy for Exposure deadline but please send  
 earlier if you can
24 Inter-Club Print Competition at Connahs  
 Quay

November 
5 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm
16 Winter Representatives Meeting at Littlton  
 Millennium Memorial Hall, @ 7.45pm.
22 SPF Exhibition Judging/Christmas Lunch
28/29 PAGB Awards for Photographic Merit  
 organised by Scottish Photographic   
 Federation

December
4 Council Meeting at Valley Park Community  
 Centre, Chandlers Ford, @ 7.30pm

PRESIDENT:  
 Mrs Lynn Lambeth

 president@southernfed.org.uk

VICE PRESIDENT: 
 Ms Terri Neill-Griffin

 vice.pres@southernfed.org.uk

IMMEDIATE PAST PRESIDENT:
 Ian Bigg LRPS CPAGB

 past.pres@southernfed.org.uk

SECRETARY:
 Ms Chris Neill-Griffin
 spf.sec@southernfed.org.uk

TREASURER:  
 Roy Lambeth CPAGB BPE1*

 treasurer@southernfed.org.uk

COMPETITION  Secretary:
 Chris Whiting

 comp.sec@southernfed.org.uk

HANDBOOK/DIR SECRETARY:
 Dave Isaacs

 handbook.sec@southernfed.org.uk

EXHIBITION SECRETARY:
 

 exhibitionsecretary@southernfed.org.uk

PAGB EXHIBITION SECRETARY:
 

 pagbexhibsec@southernfed.org.uk

SLIDE CHAMPIONSHIP SECRETARY:
 Ernie Fullbrook BEM APAGB 
 council.mem2@southernfed.org.uk

PUBLICITY SECRETARY:
 David Kessel

 publicity.sec@southernfed.org.uk

NEWSLETTER SECRETARY:
 Trevor Muston

 news.editor@southernfed.org.uk

WEBMASTER:
 Les Lloyd
 webmaster@southernfed.org.uk

RECORDS SECRETARY:
 George Walsh APAGB
 records@southernfed.org.uk

COUNCIL MEMBERS
 
 council.mem1@southernfed.org.uk

 Ernie Fullbrook BEM APAGB 
 council.mem2@southernfed.org.uk
 
 council.mem3@southernfed.org.uk

PAGB Executive Member:
 Leo Rich ARPS AFIAP DPAGB BPE2

 PAGBExec.Member@southernfed.org.uk

Non Council Members
 
Assistant Exhibition Secretary: 
 Geoff Kelland
 asst.exhib.sec@southernfed.org.uk

Diary of Events The Council 2009/2010


